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DESCRIPTION

LTC6810-1
6-Channel Battery-Stack Monitor 

with Daisy-Chain Interface

Demonstration circuit 2515B features the LTC®6810-1, a 
6-channel battery-stack monitor. Multiple boards can be 
linked through a 2-wire isolated serial interface (isoSPI™) 
to monitor a long series of cells in a stack. The DC2515B 
demo board also features reversible isoSPI enabling a 
redundant communication path. The PCB, components, 
and DuraClik connectors are optimized for Low EMI 
Susceptibility and Emissions.

The DC2515B can communicate to a PC by connecting 
a DC2792B dual master isoSPI together with DC2026 All registered trademarks and trademarks are the property of their respective owners.

PERFORMANCE SUMMARY

Linduino® One. The DC2026 must be loaded with the 
appropriate program (called a sketch) to control the bat-
tery stack monitor IC and receive data through a USB 
serial port. The DC2026C provides a standard SPI inter-
face which can be translated to isoSPI and then con-
nected to a DC2515B isoSPI port (J4 or J5 connector). 
The DC2792B companion board provides two SPI-isoSPI 
channels for reversible operation.

Design files for this circuit board are available.

Specifications are at TA = 25°C

PARAMETER MIN TYP MAX UNITS

V+ Supply Voltage 5.0 20 27.5 V

V+ to C6 Voltage –0.3 V

C0/S0 Voltage 0 5 V

VREG Supply Voltage 4.5 5 5.5 V

VREF1 1st Reference Voltage, No Load 3.1 3.2 3.3 V

VREF2 2nd Reference Voltage, 5k Load to V– 2.994 3 3.006 V

VBIAS IBIAS Voltage, READY/ACTIVE State 1.9 2.0 2.1 V

CPIN Input Range 0 5 V

Cell Count 6

https://www.analog.com/DC2515B?doc=DC2515B.pdf
https://www.analog.com?doc=DC2515B.pdf
https://www.analog.com/LTC6810-1?doc=DC2515B.pdf
https://www.analog.com/en/design-center/evaluation-hardware-and-software/evaluation-boards-kits/DC2515B.html#eb-documentation?doc=DC2515B.pdf


2

DEMO MANUAL DC2515B

Rev. 0

HARDWARE SETUP
Wiring J1 Connector

The DC2515B demo board connector pinout is critical; 
correct wiring must be followed to avoid the risk of dam-
aging the DC2515B demo board.

When connected to a battery-stack, power for the 
DC2515B is provided by the cell group being monitored. 
To connect the cell group, separate the screw-terminal 
block section from the J1 connector. Then, insert the cell-
voltage connections or resistors into the screw-terminal 
clamping contacts. These connections provide the power 
and input stimulus for the battery-stack monitor IC.

Cell-voltages are wired to J1 starting from position 4 
(most negative potential of the group). Please refer-
ence the appropriate demo board J1 connector pinout 
in Table 1.

Alternatively, resistors can be used to simulate battery 
cell-voltages. 100Ω 2W or equivalent resistors are recom-
mended because 100Ω (or lower values) typically will not 
induce measurement errors and the 2W (or greater rating) 
will keep the resistor temperatures low preventing power 
dissipation damage.

DC2515B 6 Resistor Connection

Carefully connect six 100Ω resistors onto the screw-
terminal block between each CPIN input clamping con-
tact from position 4 to position 10 as shown in Table 1, 
DC2515B J1 pinout and Figure 1. Provide a stack-equiva-
lent power supply connection to position 10 (positive) and 
position 4 (negative). The power supply may be adjusted 
to provide the desired nominal cell-voltage (ex. 19.8V will 
be 3.3V per cell).

Figure 1. Resistor Divider String

100Ω

DC2515B F01

Table 1. DC2515B J1 Pinout
J1 PIN CPIN INPUT

1 NC

2 NC

3 NC

4 C0/V–

5 C1

6 C2

7 C3

8 C4

9 C5

10 C6

11 NC

12 NC

13 NC

14 NC

15 NC

16 NC

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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DC2515B SERIAL INTERFACE OPTIONS
The isoSPI is the only communication option to DC2515B. 
Due to the custom EMI optimized isoSPI cable with 
DuraClik connectors, it’s highly recommended to use 
DC2792B dual master isoSPI demo board or equivalent 
for easy plug-and-play operation. The DC2792B dual 
master isoSPI demo board can be connected as a typi-
cal single-ended isoSPI bus master or to both ends of 
a reversible configuration with two isoSPI bus masters. 
Refer to demo manual DC2792B for usage details.

DC2792B to DC2515B Typical isoSPI Connection

A typical isoSPI connection begins with the isoSPI Master 
connected to the first (or bottom) DC2515B. Additional 
DC2515B boards can be daisy-chained onto the isoSPI 
bus. Communication begins from the first (or bottom) 
DC2515B then to the next upper DC2515B and, finally, to 
the last (or top) DC2515B.

Figure 2 shows the following connections for two boards 
on a stack interfaced to a PC:

1. Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2. Connect the DC2026 to the DC2792B dual master isoSPI 
demo board.

a. Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC2792B J1 header.

3. Connect the DC2792B to the DC2515B. This DC2515B 
is the first (or bottom) board of the stack.

a. Connect a 2-wire twisted-pair patch cable from the 
DC2792B J2 MAIN DuraClik connector to the bottom 
DC2515B J4 isoSPI A DuraClik connector.

 CAUTION! The 2-wire twisted-pair patch cable with 
the DuraClik end plugs have 1mm thick center locking 
tabs on the wiring side that must be pressed down to 
release from the DuraClik receptacles. Failure to do 
so may damage the cable and prevent board-to-board 
isoSPI communication.

4. Connect or daisy-chain the DC2515B to another 
DC2515B in isoSPI mode. This DC2515B is the last 
(or top) board of a two-board stack. More DC2515B 
upper boards can be daisy-chained together in the 
same manner.

a. Connect a 2-wire twisted-pair patch cable from the 
bottom DC2515B J5 isoSPI B DuraClik connector to 
the next upper or top DC2515B J4 isoSPI A DuraClik 
connector.

5. CAUTION! Prevent damage to the DC2515B. Refer to 
Table 1 and confirm that the cell-voltage connections 
to the screw-terminal block matches the DC2515B J1 
pinout.

a. Plug the screw-terminal blocks into the J1 cell-voltage 
connectors.

6. Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515B boards.

Figure 2. DC2792B Typical isoSPI Connection to the Bottom DC2515B in a Two-Board DC2515B Stack

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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DC2515B SERIAL INTERFACE OPTIONS
DC2792B to DC2515B Reverse isoSPI Connection

A reverse isoSPI connection begins with the isoSPI 
Master connected to the last (or top) DC2515B. Additional 
DC2515B boards can be daisy-chained onto the iso-
SPI bus. Communication begins from the last (or top) 
DC2515B then to the next lower DC2515B and, finally, to 
the first (or bottom) DC2515B.

Figure 3 shows the following connections for two boards 
on a stack interfaced to a PC:

1. Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2. Connect the DC2026 to the DC2792B dual master isoSPI 
demo board.

a. Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC2792B J1 header.

3. Connect the DC2792B to the DC2515B in isoSPI 
mode. This DC2515B is the last (or top) board of a 
two-board stack.

a. Connect a 2-wire twisted-pair patch cable from the 
DC2792B J2 MAIN DuraClik connector to the top 
DC2515B J5 isoSPI B DuraClik connector.

 CAUTION! The 2-wire twisted-pair patch cable with 
the DuraClik end plugs have 1mm thick center locking 
tabs on the wiring side that must be pressed down to 

release from the DuraClik receptacles. Failure to do 
so may damage the cable and prevent board-to-board 
isoSPI communication.

4. Connect or daisy-chain the DC2515B to another 
DC2515B in isoSPI mode. This DC2515B is the first (or 
bottom) board of a two-board stack. More DC2515B 
lower boards can be daisy-chained together in the same 
manner.

a. Connect a 2-wire twisted-pair patch cable from the 
top DC2515B J4 isoSPI A DuraClik connector to the 
next lower or bottom DC2515B J5 isoSPI B DuraClik 
connector.

5. CAUTION! Prevent damage to the DC2515B. Refer to 
Table 1 and confirm that the cell-voltage connections 
to the screw-terminal block matches the DC2515B J1 
pinout.

a. Plug the screw-terminal blocks into the J1 cell-voltage 
connectors.

6. Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515B boards.

DC2792B to DC2515 Redundant isoSPI Connection

A redundant isoSPI connection begins with the primary 
(or main) isoSPI Master connected to the first (or bot-
tom) DC2515B and has a backup auxiliary (or aux) isoSPI 

Figure 3. DC2792B Reverse isoSPI Connection to the Top DC2515B in a Two-Board DC2515B Stack

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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Master connected to the last (or top) DC2515B. Additional 
DC2515B boards can be daisy-chained between the two 
isoSPI masters on the isoSPI bus. Primary (or main) com-
munication begins from the first (or bottom) DC2515B 
then to the next upper DC2515B and, finally, to the last (or 
top) DC2515B. The backup auxiliary (or aux) communica-
tion begins in the reverse direction to provide coverage 
when a possible isoSPI daisy-chain break occurs.

Figure 4 shows the following connections for two boards 
on a stack interfaced to a PC:

1. Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2. Connect the DC2026 to the DC2792B dual master isoSPI 
demo board.

a. Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC2792B J1 header.

3. Connect the DC2792B primary (or main) isoSPI master 
to the first (or bottom) DC2515B board of the stack.

a. Connect a 2-wire twisted-pair patch cable from the 
DC2792B J2 MAIN DuraClik connector to the bottom 
DC2515B J4 isoSPI A DuraClik connector.

 CAUTION! The 2-wire twisted-pair patch cable with 
the DuraClik end plugs have 1mm thick center locking 
tabs on the wiring side that must be pressed down to 
release from the DuraClik receptacles. Failure to do 

so may damage the cable and prevent board-to-board 
isoSPI communication.

4. Connect or daisy-chain the DC2515B to another 
DC2515B in isoSPI mode. This DC2515B is the last 
(or top) board of a two-board stack. More DC2515B 
upper boards can be daisy-chained together in the 
same manner.

a. Connect a 2-wire twisted-pair patch cable from the 
bottom DC2515B J5 isoSPI B DuraClik connector to 
the next upper or top DC2515B J4 isoSPI A DuraClik 
connector.

5. Connect the DC2792B auxiliary (or aux) isoSPI Master 
to the last (or top) DC2515B board of the stack.

a. Connect a 2-wire twisted-pair patch cable from the 
DC2792B J3 AUX DuraClik connector to the top 
DC2515B J5 isoSPI B DuraClik connector.

6. CAUTION! Prevent damage to the DC2515B. Refer to 
Table 1 and confirm that the cell-voltage connections 
to the screw-terminal block matches the DC2515B J1 
pinout.

a. Plug the screw-terminal blocks into the J1 cell-voltage 
connectors.

7. Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515B boards.

Figure 4. DC2792B Redundant isoSPI Connections to the Bottom and Top DC2515B in a Two-Board DC2515B Stack

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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SOFTWARE SETUP
The DC2515B can be controlled with the DC2026 Linduino One board together with DC2792B dual isoSPI Master or 
equivalent isoSPI transceiver. The DC2026 is part of the Arduino compatible Linduino platform that provides example 
code that will demonstrate how to control the multicell battery-stack monitor ICs. Compared to most Arduino compat-
ible microcontroller boards, the DC2026 offers conveniences such as an isolated USB connection to the PC, built-in 
SPI MISO line pull-up to properly interface with the battery stack monitor IC open drain SDO, and an easy ribbon cable 
connection for SPI communication through the DC2792B 14-pin QuikEval™ J1 connector.

Arduino IDE Setup

1. Download then install the Arduino IDE onto the PC. Detailed instructions can be found under the quick start tab.

2. Set the Arduino IDE to open BMS Sketchbooks. From within the Arduino IDE, click on File menu select Preferences. 
Then under Sketchbook location: select Browse and locate the path to the extracted LTSketchbook.zip file that was 
downloaded (see Figure 5).

Figure 5. Sketchbook Location Path

https://www.analog.com/DC2515B?doc=DC2515B.pdf
https://www.analog.com/en/design-center/evaluation-hardware-and-software/linduino.html?doc=DC2515B.pdf
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SOFTWARE SETUP
3. Close then re-open the Arduino IDE to enable the use of the Sketchbook Location that was previously set.

4. Select the correct COM port to allow communication to DC2026 through USB. Under the Tools menu, select Port 
➞ Select the highest number COMxx with the ✓ check mark symbol. There may be more than one option; DC2026 
is usually the highest COM port number. The PC screenshots (Figure 6) used in this example show the DC2026 
connected to COM6.

5. Select the correct Arduino compatible microcontroller board. Under the Tools menu, select Board ➞ Arduino/
Genuino Uno with the ● black dot symbol (see Figure 7).

Figure 6. Selecting Correct COM

Figure 7. Selecting Compatible Microcontroller Board

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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SOFTWARE SETUP
6. Open one of the programs or sketches associated with the DC2515B. In this example LTC6810 sketch will be opened. 

Under the File menu, select Sketchbook ➞ Part Number ➞ 6000 ➞ 6810 ➞ DC2515 (see Figure 8).

Figure 8. Selecting the LTC6810 Sketch

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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SOFTWARE SETUP
7. Upload the DC2515 sketch onto the DC2026 by clicking on the Upload button on the top left corner. When this 

process is completed there will be a Done Uploading message on the bottom left corner (see Figure 9).

Figure 9. Uploading DC2515 Sketch

Figure 10. Arduino Serial Monitor Tool

8. Open the Arduino Serial Monitor (Figure 10) tool. Click on the Serial Monitor button on the top right corner then 
the Serial Monitor window will open and show on the top left corner the COMxx used.

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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9. Configure the Serial Monitor to allow communication to the DC2026 through USB. On the bottom of the Serial 

Monitor window, set the following starting from bottom left to bottom right:

a. Click on the Autoscroll checkbox for the ✓ check mark symbol.

b. Select Both NL & CR on the left dropdown menu.

c. Select 115200 baud on the right dropdown menu.

d. As shown in Figure 11, when configured correctly the DC2515 sketch menu will appear.

Figure 11. DC2515 Sketch Menu

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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APPENDIX A: THE SKETCHBOOK CONTENTS

Figure 12. Documentation Directory

The LTSketchbook will generally contain the following 
folders: Libraries, Part Number, Documentation, and 
Utilities.

Libraries directory: Contains a subdirectory for each IC in 
the sketchbook. Each subdirectory contains a .cpp and .h 
file. These files contain all of the constant definitions and 
low-level IC command implementations. Porting to a differ-
ent microcontroller requires changes to some library files.

Part Number directory: Contains example control pro-
grams for each IC. Inside the 6000 folder of the Part 
Number folder, each 68xx folder is a BMS IC with a 
sketch(.ino) file that implements a control program to 
evaluate the functionality of the IC. This sketch allows 
the user to control the IC through a serial terminal and 
make all primary measurements. This sketch also allows 

for evaluation of self-test and discharge features of the IC. 
Generally, the name of a sketch relates to the IC’s demo 
board. For example, the sketch for LTC6804 is DC1942.
ino, for LTC6811 it is DC2259.ino, and for LTC6810 it is 
DC2515.ino.

Utilities directory: Contains support programs, includ-
ing a program that emulates a standard Analog Devices 
DC590 isolated USB to serial controller.

Documentation directory: Contains html documentation 
for the provided code base. Documentation for all of the 
BMS ICs can be accessed by opening the Linduino.html 
file, as found in the main sketchbook directory (Figure 12) 
and in the Documentation directory.

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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APPENDIX A: THE SKETCHBOOK CONTENTS
What Is A Sketch

A sketch is simply another word for a microcontroller/
Linduino program. The term is generally only used when 
referring to Arduino-based programs, as sketches have 
several abstractions that remove some of the complex-
ity of a standard microcontroller (MCU) program. All 
sketches contain two primary functions, the setup() and 
the loop() function. These are in fact the only functions 
that are mandatory in a sketch and are almost always 
implemented in some form in a typical MCU program. 
The setup() function is run once at power on or after the 
MCU is reset. The setup() function generally is used to 
initialize the MCU peripheral circuits and to initialize all 
of the control variables. The loop() function is similar to 
a main() function that has implemented an infinite loop 
inside a standard C program. The code within the loop()
function is typically where the primary program code is 
placed. The code within the loop() function will repeat 
infinitely.

Sketch Modifications

Sketches can be modified to a set of applications spe-
cific requirements. All sketches are written such that the 
most common modifications can be made by changing 
the variables listed in the /*Setup Variables */ table at the 
top of the sketch. For reference, example modifications 
to a DC2259 (LTC6811) sketch are shown below. These 
modifications are applicable to most of the available BMS 
ICs in the sketchbook.

Common modifications can be made by changing the 
Setup Variables. The most common application changes 
are listed below. After the variables are changed, the 
sketch will need to be recompiled and uploaded to the 
Linduino.

1. To change the number of ICs in the isoSPI network, 
change the TOTAL_IC variable. A number between 1 

and 4 should be entered. In an application that has 2 
devices in the network the modified line will look like 
the following.

 const uint8_t TOTAL_IC = 2;

2. Often an application may need to sample data at a rate 
faster than the default 500ms (2Hz). To modify the loop/
sample rate the MEASUREMENT_LOOP_TIME variable 
should be changed. The loop time must be entered in 
milliseconds and should be a number larger than 20ms. 
To change the loop rate to roughly 10 measurements 
a second the loop rate should be changed to 100ms. 
The modified line will look like the following.

 const uint16_t MEASUREMENT_LOOP_TIME = 100;

3. It is possible to modify which measurements fall within 
the loop during the Loop Measurements command. The 
following list are the measurements that can be looped.
const uint8_t MEASURE_CELL = ENABLED;

// This is ENABLED or DISABLED

const uint8_t MEASURE_AUX = DISABLED;

// This is ENABLED or DISABLED

const uint8_t MEASURE_STAT = DISABLED;

//This is ENABLED or DISABLED

 By default, only a cell measurement is done, as noted 
by MEASURE_CELL = ENABLED. What measurements 
are made can be changed by setting what the Measure 
field is equal to. To Measure Cells and the Status register 
but not the AUX register, the variables would be setup 
as shown below.
const uint8_t MEASURE_CELL = ENABLED;

// This is ENABLED or DISABLED

const uint8_t MEASURE_AUX = DISABLED;

// This is ENABLED or DISABLED

const uint8_t MEASURE_STAT = ENABLED;

//This is ENABLED or DISABLED

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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APPENDIX A: THE SKETCHBOOK CONTENTS
4. ADC conversion settings can also be modified in the 
Setup Variables section. The default setup is to run the 
ADC in Normal mode, which has a 7kHz filter code; in this 
mode the ADC_OPT bit is disabled. Typical choice for which 
cell to convert is ALL. Full ADC conversion programming 
requires setting ADC_OPT, ADC_CONVERSION_MODE, 
CELL_CH_TO_CONVERT, AUX_CH_TO_CONVERT, 
and STAT_CH_TO_CONVERT. These variables are pro-
grammed with constants listed in the LTC68xy_daisy.h 
file. For simplicity they are also listed below.

MD_422HZ_1KHZ

MD_27KHZ_14KHZ

MD_7KHZ_3KHZ

MD_26HZ_2KHZ

ADC_OPT_ENABLED

ADC_OPT_DISABLED

CELL_CH_ALL

CELL_CH_1and7

CELL_CH_2and8

CELL_CH_3and9

CELL_CH_4and10

CELL_CH_5and11

CELL_CH_6and12

 To set the ADC to have a 1kHz filter corner the ADC_OPT 
and ADC_CONVERSION_MODE variables would be 
changed as follows.
ADC_OPT = ADC_OPT_ENABLED;

ADC_CONVERSION_MODE = MD_422HZ_1KHZ;

 To convert only cells 2 and 8,
CELL_CH_TO_CONVERT = CELL_CH_2and8;

5. In another example, the user may wish to change the 
undervoltage and overvoltage thresholds. Each number 
is based on an LSB of 100µV.
//Under Voltage and Over Voltage Thresholds

const uint16_t OV_THRESHOLD = 41000;

// Over voltage threshold ADC Code.

// LSB = 0.0001

const uint16_t UV_THRESHOLD = 30000;

// Under voltage threshold ADC Code.

// LSB = 0.0001

https://www.analog.com/DC2515B?doc=DC2515B.pdf
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ESD Caution 
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and 
conditions set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation 
Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) 
and Analog Devices, Inc. (“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to 
Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and 
agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted 
is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third 
Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is 
NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all 
be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of 
use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile 
or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited 
to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS 
Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF 
LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY 
DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS 
LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING 
BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE 
HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States 
federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts 
(excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits 
to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

https://www.analog.com/DC2515B?doc=DC2515B.pdf
https://www.analog.com?doc=DC2515B.pdf
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